Bonus Appendix 1

Modifiers, Maps, and Materials

The Autodesk® 3ds Max® 2013 platform offers a multitude of modifier and material options. So many, in fact, that to do a tutorial on all of them would require a multivolume book. After reading the first few chapters of this book, however, you’ll have a good understanding of how 3ds Max works, and you’ll be able to use most, if not all, of the modifiers and materials with a little experimentation and some help from this appendix.

This appendix is intended to give you general information about the modifiers and materials and to show you what types of features are available. If you need more detailed information about the modifiers and materials, consult the 3ds Max Help System, which offers full descriptions of the options and parameters for all the items discussed in this appendix. Choose Help ➤ Autodesk 3ds Max Help. This opens your default Internet browser to the Online Help System. If you want, you can also download and install a local copy of the Help System. Once you have started the 3ds Max Help System, click the Search tab in the panel to the left, enter the name of the item in the blank input box with the magnifier icon, and then click the drop-down menu to select where you want to search—Everywhere, the Documentation, Scripting & Customization, or the Developer’s Documentation (Software Development Kit). If you see only a single panel in the User Reference, click the Show In Contents button in the upper-right corner.

Modifiers

The tutorials in this book cover the most commonly used modifiers in 3ds Max. Every now and then, you’ll need to use one of the modifiers that is not discussed at any length in this book. For those situations, you can find a description of the modifier in this section. This description should be enough to get you started. Even if you don’t need all of these modifiers now, you may want to review their functions so that you’ll know what’s available.

The modifiers are all on a single drop-down list. The Modifier list is broken down into three categories: Selection modifiers, World-Space modifiers, and Object-Space modifiers. This appendix presents the modifiers in the same order as they appear in the drop-down list, starting with the Selection modifiers. Not all of the modifiers appear in the Modifier list simultaneously because the list changes depending on the type of object currently being edited. Only the modifiers that work with the selected object are displayed in the list, so modifiers will appear and disappear in the list, depending on what you have selected in the viewport.

Selection Modifiers

The Selection modifiers allow you to gain access to the sub-object levels of objects. Once sub-objects are selected with a Selection modifier, other modifiers can be placed above them in the
stack to affect only the sub-object selection. This process is also referred to as passing a sub-object selection up the stack. To add a modifier to the top of the stack that affects the entire object, rather than just a sub-object selection, first apply another Selection modifier; then, without making a sub-object selection, apply the next modifier. The entire object is again affected by any modifiers applied to the top of the stack.

**Mesh Select**

The Mesh Select modifier allows you to gain access to the sub-object level of an object to select part of the object. You can then apply another modifier to affect only what you selected with Mesh Select. For example, you could use Mesh Select to select part of an object, and then you could apply the Taper modifier only to the selected part. You can use Mesh Select to pass selections up the stack to other modifiers or to gain access to mesh sub-object selection for Patch and NURBS surfaces. You can also use Edit Poly and Edit Mesh modifiers to select sub-object levels as you do when using Mesh Select.

**Patch Select**

The Patch Select modifier allows you to gain access to the sub-object level of an object to select part of the object. It works in a similar manner to the Mesh Select modifier, but Patch Select treats objects as if they were editable patches rather than meshes.

**SplineSelect**

The SplineSelect modifier lets you affect sub-object selections of splines. Much of the functionality of the SplineSelect modifier is also found in the Edit Spline modifier.

**Poly Select**

The Poly Select modifier is similar to the Mesh Select modifier since it lets you select sub-objects of Editable Poly objects to be passed up the stack.

**Vol. Select**

The Vol. Select modifier lets you make sub-object selections based on a volume. You have the choice of four volume types: Box, Sphere, Cylinder, and Mesh Object. A Selection gizmo in the shape of the volume type you select appears in the design. You can then select the sub-object level of the Vol. Select modifier to move the Volume gizmo into place to make the selection. This is very powerful because you can base the selection on an object. For example, you can animate an object moving across a terrain and have the vertices in the terrain selected based on the position of the object.

**NSurf Sel**

NSurf Sel allows you to place sub-object selections anywhere in the stack of NURBS objects. This is similar to the Mesh Select modifier but is available only for NURBS objects.
World-Space Modifiers

*World-Space modifiers (WSMs)* are modifiers that use the World Space as their point of reference, as opposed to the Object Space of the object to which they are bound. The MapScalar modifier is a good example of a WSM, because it associates the map of an object with the World Space and isn’t affected by the Object Space of the object to which it’s attached. An object using the MapScalar modifier can be scaled to any size or shape, and any maps attached to the object won’t be scaled.

**Identifying the Modifier Types**

The World-Space modifiers can be recognized by their (WSM) suffix.

**Camera Map (WSM)**

At times, you may want an object to be invisible while it maintains a presence in a scene. For example, suppose you have a fairly detailed background image that shows a garage, and you want to create the illusion of a car entering the garage. You can create a simple box with an opening similar in shape to the background garage opening, and then use the Camera Map modifier to blend the box into the background. Once you do that, you can animate the car to drive into the box. The net effect is that the car appears to drive into the garage in the background image in your final animation. This allows you to keep the geometry simple yet still have an animation that shows a fair amount of detail.

The Camera Map modifier applies a planar UVW map to an object, and it aligns that map so that it’s perpendicular to a specified camera. The map is typically the same as the background, giving the illusion of an invisible object. Because the object can cast and receive shadows, you can create different effects. For example, if you’re using the Camera Match tool to match a building design to a photo of a building site, you can use the Camera Map modifier to include shadows on buildings in the background.

This modifier can be used when a camera is in motion, since it updates the map at each frame. There is also an Object-Space modifier (OSM) version.

**Displace Mesh (WSM)**

Displace Mesh lets you deform a surface using a bitmap image. It’s similar to including a displacement map in a material to an object, but instead of simply creating the illusion of a bumpy surface by changing the surface normals, Displace Mesh actually changes the geometry to a bumpy surface. See Chapter 8, “Enhancing Models with Materials,” for a detailed description of the Displace Mesh modifier.

If you assign a displacement map to an object, you usually won’t be able to see the effects of the map until the object is rendered. The Displace Mesh modifier allows you to see the effects of a displacement map while you’re editing. Displace Mesh can also let you convert a displacement map into an Editable Mesh, as described in Chapter 8.
**Displace NURBS (WSM)**

The Displace NURBS modifier performs the same function as the Displace Mesh modifier, but it is applied to NURBS objects.

**Hair and Fur (WSM)**

The Hair and Fur (WSM) modifier can be applied to objects to create a number of effects, including grass, in your rendered scenes. See Chapter 15, “Finishing It Off: Atmosphere, Effects, and Compositing,” for an explanation on the use of the Hair and Fur (WSM) modifier.

**MapScaler (WSM)**

Apply this version of the modifier when you want the material map to maintain its original scale, regardless of the scale of the object to which it is applied. This modifier allows you to “lock” a map’s scale so that changes to the object don’t affect the associated map. Use the Object-Space Modifier (OSM) version to lock the associated map’s scale to Object Space instead.

**PatchDeform (WSM)**

This modifier allows you to deform an object based on the form of a Patch object. A Patch object is an object that can be formed into a smooth, curved surface by editing its vertices. You can, for example, create a plane and then convert the plane into an editable patch. The vertices of the editable patch can then be edited to shape the plane into a smooth, curved surface of any shape you want. Such a surface can be used to deform other objects, using the PatchDeform modifier. The object moves to the location of the patch with the WSM version. See also the OSM version of this modifier.

**PathDeform (WSM)**

The PathDeform modifier works in a way similar to the PatchDeform modifier but uses a spline or NURBS curve instead of a Patch object. For example, you can use this modifier to deform an object along the path of the spline. An example of this would be the curving of text to conform to the shape of a round column or sphere. The object moves to the path used for the deformation in this version of the modifier. See the OSM version also.

**Point Cache (WSM)**

The Point Cache (WSM) modifier works the same as the Object Space Modifier (OSM) Point Cache modifier, using World-Space coordinates instead of an object’s Local-Space coordinates.

**Subdivide (WSM)**

The Subdivide modifier allows you to apply a radiosity mesh to an object manually. Subdivide works in a similar way to the Radiosity Meshing parameters but, instead of applying a mesh globally, Subdivide lets you apply a mesh to single objects or even sub-object levels. Because it’s a modifier, it can be edited directly from the modifier stack. The size of the subdivided mesh is locked to World Space with this modifier; if you scale the object, the mesh stays the same size.
**SURFACE MAPPER (WSM)**

The UVW Map modifier has a fixed set of seven mapping options that allow you to apply a map to most forms. But what happens when none of those options will work for your design? If you have an organic form that requires custom mapping, you can use the Surface Mapper modifier.

The Surface Mapper modifier requires that you create a NURBS surface that you edit to the form of the required map. You form the NURBS surface around the object to which you are applying the map and assign the same material to both the NURBS surface and the object. Once this is done, you apply the Surface Mapper modifier to the object or objects. The map is projected onto the modified object(s), based on the direction of the normals on the NURBS surface. In this version of the modifier, the scale of UVW space is tied to World Space; if you scale the object, the UVW coordinates remain in their original size.

**SURFDEFORM (WSM)**

The SurfDeform modifier works in a way similar to the PathDeform modifier but uses a NURBS surface instead of a curve. You can use this modifier to deform an object, based on the shape of a NURBS surface. This version stays locked to World Space.

**Object-Space Modifiers**

Object-Space modifiers directly affect the object to which they are applied in the local coordinate system of the object itself. Object Space is generally described in UVW coordinates when dealing with texture maps.

**AFFECT REGION**

The Affect Region modifier lets you apply a bulge to a surface. Two points control the bulge. One point sets the base of the bulge, while the other locates the tip of the bulge. Each point can be adjusted independently of the other. You can control the bulge’s shape through Falloff, Pinch, and Bubble parameters.

**ATTRIBUTE HOLDER**

The Attribute Holder modifier has no settings of its own, but it allows you easily to keep track of custom attributes applied to objects using the Parameter Editor.

**AUTOMATIC FLATTEN UVs**

This is the same as the Unwrap UVW modifier. This modifier is automatically applied by the Render To Texture operation.

**BEND**

You can bend an object on any axis by using the Bend modifier. You can control the degree of the bend, the place where it occurs, and the axis about which it occurs. This modifier is demonstrated in Chapter 2, “Introducing Objects.”
Bevel

Bevel allows you to extrude a 2D shape and add beveled edges. The Bevel Values rollout for this modifier allows you to set the height of the extrusion. You can use three levels of beveling. Each level has its own Height and Outline settings so that you can control beveling by adjusting the height and changing the Outline value and then expanding or contracting the shape of the outline at the top of selected level. The Surface parameters let you control the segments of the extrusion and whether the sides are curved or straight. Typically, Bevel is used to bevel text, but it can be used for other 2D shapes (see Figure BA1.1).

Bevel Level 1
Bevel Level 2
Bevel Level 3

Bevel Profile

Bevel Profile is like a simplified Loft tool. You can use it to extrude a shape along a path. This modifier is an excellent tool for creating extruded forms such as elaborate picture frames or curved shapes. To use it, you draw an outline or cross-section of the object, using a spline. Draw another spline indicating the profile or path of the object. Select the outline and then apply the Bevel Profile modifier. In the Parameters rollout of the Bevel Profile modifier, click the Pick Profile button and select the spline you want to use as the profile. The outline is extruded to the shape of the profile (see Figure BA1.2).

Once you’ve extruded a shape using the Bevel Profile modifier, you can modify the shape by adjusting either the profile spline or the original extruded shape. Bevel Profile is similar to the more powerful Sweep modifier discussed later in this appendix.

Camera Correction Modifier

Wide-angle camera views tend to exaggerate the three-point perspective view of tall objects. The tops of buildings, for example, appear to taper to a sharp point too quickly. The Camera Correction modifier enables you to reduce this distortion.
The Camera Correction modifier is unusual in that it isn’t found in the Modifier list dropdown. To use it, you must first select the camera on which you want to work, right-click the camera, and then select Apply Camera Correction Modifier from the tools 1 quad menu, as shown in Figure BA1.3.

**Figure BA1.2**
An example of the Bevel Profile modifier

**Figure BA1.3**
Accessing the Camera Correction modifier

**Applying the Camera Correction Modifier**
You can also apply the Camera Correction modifier by first selecting the camera and then, from the Main menu, choosing Modifiers ➔ Cameras ➔ Camera Correction.
Once you’ve done that, you can adjust the camera view using the options in the 2-Point Perspective Correction rollout that appears on the Modify tab of the Command panel.

**Camera Map (OSM)**

Similar to the Camera Map (WSM) modifier example earlier in this appendix, at times you may want an object to be invisible while it maintains a presence in a design. For example, suppose you have a fairly detailed background image that shows a garage and you want to create the illusion of a car entering the garage. You can create a simple box with an opening similar in shape to the background garage opening and then use the Camera Map modifier to blend the box into the background. Once you do that, you can animate the car to drive into the box. The net effect is that the car appears to drive into the garage in the background image in your final animation. This allows you to keep the geometry simple yet still have an animation that shows a fair amount of detail.

The Camera Map modifier applies a planar UVW map to an object, and it aligns that map so that it’s perpendicular to a specified camera. The map is typically the same as the background, giving the illusion of an invisible object. Because the object can cast and receive shadows, you can create different effects. For example, if you’re using the Camera Match tool to match a building design to a photo of a building site, you can use the Camera Map modifier to include shadows on buildings in the background.

The Object-Space version of this modifier is a better choice when there is no camera motion. (See also the “Matte/Shadow” section later in this appendix.)

**Cap Holes**

Some editing procedures will leave openings in a mesh. You may, for example, use the Slice modifier to slice an object into two halves. Each half will have an opening at the Slice plane. The Cap Holes modifier can be used to close the openings.

In 3ds Max, a hole is a closed loop of edges with a single face. Cap Holes works best on planar holes, but it also works on nonplanar holes. Cap Holes is a very useful tool when used in conjunction with the STL Check modifier; if you find problems in a mesh with the STL (stereolithography) check, using Cap Holes may fix those problems.

**Cloth**

The Cloth modifier is used for simulating cloth objects that must interact dynamically with other objects in your scenes. The Cloth modifier can be used to simulate flags or tensile structures in your projects. The Cloth modifier can also be used with the Garment Maker modifier.

**CrossSection**

The CrossSection modifier is a powerful tool that lets you connect splines to form surfaces. (If you’re an AutoCAD user, you can think of CrossSection as a super Rulesurf or Edgesurf command.) This modifier is called CrossSection because, with it, you can draw cross sections of an object and then join the cross sections together to form a surface.

When used in conjunction with the Surface modifier, CrossSection lets you form elaborate patch surfaces by defining the surface edge with two or more 3D splines. First you draw the splines; then you attach them to form a single object, using the Attach option in the Modify tab.
You then apply the CrossSection modifier, which connects the vertices of the separate splines. Finally, you can “skin” over the splines with the Surface modifier (see Figure BA1.4).

**Figure BA1.4**
Creating a surface using the CrossSection modifier and the Surface modifier

The order in which the splines are created is as important as the location of the starting vertex of the splines. You want to be sure that the splines point in the same direction, with the beginning vertex of each spline placed in the same orientation relative to the rest of the spline. Figure BA1.5 shows how all the splines are oriented with their starting points (the white vertices) to the left of the figure.

**Figure BA1.5**
Aligning the spine vertices
If you collapse the Modifier stack of a surface created using the CrossSection and Surface modifiers, you have a patch surface that can be edited in the same way as any other patch surface.

**DELETEMESH**

You can think of the DeleteMesh modifier as a tool that lets you try out deletions in a mesh before committing to the change. Because it’s a modifier, it can be placed anywhere in the modifier stack. Here’s how it works: go to the sub-object level of an object, and make a selection of the item you want to remove. If it’s a surface patch or NURBS surface, you can isolate mesh surfaces for deletion by using the Mesh Select modifier. Once you’ve made your selection, apply the DeleteMesh modifier. The selection will be deleted. Because DeleteMesh is a modifier, you can restore the deleted items by removing DeleteMesh from the modifier stack.

**DELETEPATCH**

You can think of the DeletePatch modifier as a tool that lets you try out deletions in a Patch object. Because it’s a modifier, it can be placed anywhere in the modifier stack. It works in a similar way to the DeleteMesh modifier (described in the previous section). Because DeletePatch is a modifier, you can restore the deleted items by removing DeletePatch from the modifier stack.

**DELETESPLINE**

DeleteSpline is similar to DeleteMesh except that it works on splines rather than on meshes. Sub-object selections are limited to vertices, segments, and splines.

**DISP APPROX**

The Disp Approx modifier allows you to apply a displacement map to an object through a material channel. A tutorial for this modifier can be found in Chapter 8.

**DISPLACE**

The Displace modifier allows you to apply a displacement map directly to an object without having to do it through a material. This is similar to the Disp Approx modifier, but no materials are required.

**EDIT MESH**

Like the Edit Spline modifier, Edit Mesh seems a bit redundant, because it duplicates the parameters for Editable Meshes. However, Edit Mesh offers great flexibility in editing meshes by allowing you to position edits in the modifier stack. You can experiment with changes in a mesh, maintain other modifiers and parameters that would otherwise be altered by mesh edits, or edit multiple mesh objects.

The Edit Mesh modifier uses much more memory than does a simple Editable Mesh object. For this reason, try to avoid using this modifier unless you really need the flexibility it offers.
**EDIT NORMALS**

The Edit Normals modifier gives you control over an object’s vertex normals, and it is intended for use on meshes that will be sent to game engines or other real-time 3D rendering engines that support vertex normals.

**EDIT PATCH**

The Edit Patch modifier lets you edit an object as if it were an Editable Patch object. The Edit Patch modifier uses a good deal of RAM, since it must make a copy of the selected geometry in RAM in order to perform its functions. Nevertheless, Edit Patch is offered for those occasions when you want to try out options or when prior modifiers or parametric options must be left in place.

**EDIT POLY**

The Edit Poly is yet another modifier that lets you edit an object as if it were a simple geometric object, an Editable Poly object in this case. Using the Edit Poly modifier gives you control of all of the Editable Poly tools without actually converting the mesh to an Editable Poly. Use this modifier only to experiment with the tools and then convert the object or collapse the modifier stack to save the edits and reduce the file size and RAM usage. Edit Poly is generally preferred over Edit Mesh because of its richer toolset.

**EDIT SPLINE**

The Edit Spline modifier may seem redundant because it duplicates the parameters for Spline objects, with a few limitations. Edit Spline offers flexibility in editing splines by allowing you to position edits anywhere in the modifier stack. For example, you can use Edit Spline to test spline edits. Because it’s a modifier, you can easily discard changes made using Edit Spline by deleting it from the modifier stack—something you cannot do using the basic parameters for a spline. Edit Spline is also useful for applying changes to several shapes at once by applying a single Edit Spline modifier to a set of objects. You may also want to maintain other modifiers that would otherwise be affected by changes to the basic parameters of the shape.

---

**CONSIDER MEMORY USAGE WITH THE EDIT SPLINE MODIFIER**

The Edit Spline modifier uses much more memory than does a simple Editable Spline object. For this reason, try to avoid using this modifier unless you really need the flexibility it offers.

---

**EXTRUDE**

Extrude is used to extend 2D shapes into the third dimension in a linear fashion. 3ds Max shapes, NURBS curves, and shapes imported from CAD programs can all be extruded. The Extrude modifier offers the option to cap ends, which closes the openings formed by the top and bottom of an extruded, closed shape. You can also select the type of mesh that is created with Extrude.
FACE EXTRUDE
The Face Extrude modifier allows you to extrude only selected faces of a mesh. You must first make a selection of faces on the sub-object level of an object. You can then apply the Face Extrude modifier to affect the selected faces. Although you can use the Extrude option at the sub-object level of an Editable Mesh or Editable Poly, the Face Extrude modifier uses fewer resources and offers a few additional options, such as Scale and Extrude From Center. You can achieve a beveled effect with these options. A selection modifier must be placed below Face Extrude and a sub-object selection must be passed up to it.

FFD (2 × 2 × 2, 3 × 3 × 3, 4 × 4 × 4)
The Free Form Deformation (FFD) modifiers let you deform objects in a general way by offering lattice control points to pull and stretch objects. When you apply an FFD modifier, a lattice box appears around the selected object. You can use the control points on the box to push or pull the object’s form (see Figure BA1.6). The lattice box is a type of gizmo and doesn’t represent actual geometry.

Figure BA1.6
A couch with the FFD 4 × 4 × 4 modifier

The FFD modifiers are offered in three types: 2 × 2 × 2, 3 × 3 × 3, and 4 × 4 × 4. Each type places a different box around the object. The FFD 2 × 2 × 2 modifier, for example, places a box with control points at each corner.

FFD (box)
The FFD (box) modifier is similar in function to the previous FFD modifiers but adds the capability to control the number of control points. With FFD (box), you aren’t limited to the 2 × 2 × 2 through 4 × 4 × 4 lattice of the FFD modifier, as shown in Figure BA1.7.

FFD (cyl)
Like the FFD (box) modifier, FFD (cyl) allows you to set the number of control points in the control lattice, but instead of a box, FFD (cyl) places a cylindrical lattice around the object.
MODIFIERS

Figure BA1.7
An FFD (box)
modifier applied to
a couch using a 5 × 6
× 7 lattice

Fillet/Chamfer

The Fillet/Chamfer modifier lets you convert a spline vertex into a filleted (rounded) corner or a chamfered corner. It works only on vertices that connect straight segments, and it won’t join two disconnected segments. To use it, select a shape and then apply the Fillet/Chamfer modifier. The Vertex sub-object level is automatically opened, allowing you to select a vertex for editing. You can either select a vertex and enter a fillet or chamfer value in the Edit Vertex rollout or set a fillet or chamfer value first and then select a vertex and click the Apply button.

Flex

The Flex modifier can be used to simulate soft body dynamics by connecting an object’s vertices with virtual springs that can be given varying amounts of stiffness and stretchiness. Flex can also be used to give objects secondary motion so that you don’t have to animate it yourself. Secondary motion is the result of primary motion, and it is one of the cornerstones of making animation lifelike, such as the wiggling of Jell-O after it falls onto a plate (or the floor) or the cheeks and jowls of a large, jolly character who is laughing exuberantly.

Garment Maker

The Garment Maker modifier allows you to use splines to create 2D patterns for objects to be used with the Cloth modifier, which can be used to simulate how cloth reacts in an environment.

HSDS

HSDS stands for Hierarchical Subdivision Surfaces. The HSDS modifier subdivides the surface of an object. You can use it to help smooth out a curved surface of an object without reducing the object to a mesh.

Lathe

Lathe is used to revolve 2D shapes into the third dimension in a circular fashion. 3ds Max shapes, NURBS curves, and shapes imported from CAD programs can be lathed. The Lathe
modifier offers the option to cap the ends, which closes the openings formed by the beginning and end of a closed shape that is lathed if the Degrees value is less than 360. You can also select the type of output (Patch, Mesh, or NURBS) that is created with Lathe.

**LATTICE**

The Lattice modifier lets you convert the segments of a shape or the edges of an object into struts and the vertices into joints. The effect is similar to that of converting a mesh object into a wireframe but expressing the wireframe as renderable geometry (see Figure BA1.8). The structural framing system for a geodesic dome is a good architectural example of using a latticed geosphere.

**Figure BA1.8**
A tapered cylinder converted into a lattice

![A tapered cylinder converted into a lattice](image)

You can change the selected object so that only its joints appear, as shown in Figure BA1.9.

**Figure BA1.9**
A tapered cylinder with its joints converted into icosahedrons

![A tapered cylinder with its joints converted into icosahedrons](image)
In addition, Lattice allows you to display both joints and struts to form some unusual objects. You have control over the number of sides of the struts or the type of geometry used at the vertices. You can also change the scale of the joints and struts.

**Linked XForm**

The Linked XForm modifier is used to link the position, rotation, or scale transforms for a control object or its sub-objects to another object or sub-object.

**MapScaler**

Apply this OSM version of the modifier when you want the material map to maintain its scale relative to the scale of the object. Changes to the object’s scale will also affect the associated map’s scale. Use the WSM version to lock the associated map’s scale to World Space instead.

**Material**

When you apply a Multi/Sub-Object material to an object, you need to assign a material ID to selected faces of the object in order to correlate the sub-material with the selected faces (see Chapter 8 for a look at Multi/Sub-Object materials). The Material modifier lets you do just that.

The Material modifier isn’t needed for Editable Meshes or Editable Polys. It’s intended for other types of objects that don’t offer access to mesh-level editing. For those objects, you need to apply the Mesh Select modifier first in order to select mesh faces. You can then apply the Material modifier to assign a material ID.

**MaterialByElement**

The MaterialByElement modifier applies the different materials of a multi/sub-object material to the different elements of an object. This is done randomly.

**Melt**

The Melt modifier allows you to make an object appear as if it were melting. The modifier is applied parametrically with settings for the amount of Melt, Spreading based on a percentage, and a Solidity parameter with presets for ice, glass, jelly, plastic, and user-defined custom value.

**MeshSmooth**

MeshSmooth does just what the name implies: it smoothes a mesh so that sharp corners are rounded. It does this by increasing the complexity of the mesh. The smoothed form can be edited by using control vertices (CVs) in a way similar to NURBS CVs. MeshSmooth is similar to the TurboSmooth modifier described later in this appendix.

**Mirror**

Mirror performs a similar function to the Mirror tool on the 3ds Max Main Toolbar. Instead of creating a second object when the Clone option indicates to do so with the Mirror tool, the Mirror modifier creates a second set of geometry, using the Copy option; however, both
instances of the geometry are elements of the same object. Because it’s a modifier, you can control the mirror effect as part of the object’s modifier stack.

**Morpher**
The Morpher modifier is used to change the shape of a mesh, patch, NURBS objects, splines, and FFDs. The Morpher modifier can also be used to morph between different materials.

**MultiRes**
The MultiRes modifier is similar to the Optimize modifier, with the added option to specify the level of simplification as a percentage or number of vertices. The more powerful MultiRes has generally replaced Optimize for mesh simplification operations.

**Noise**
The Noise modifier randomly repositions the vertices of an object to simulate an uneven surface. You can adjust the strength of the noise to create a relatively smooth surface or a mountainous terrain. The effectiveness of Noise is dependent on the amount of segmentation of the object.

**Normal**
When you create geometry in 3ds Max, the normals of the geometry are pointing outward and you don’t have control over their orientation. You can gain control of the normals of 3ds Max geometry by collapsing the stack and reducing the geometry to an Editable Mesh. Unfortunately, once you do that, the geometry loses its parametric functions. The Normal modifier lets you control the normals of 3ds Max geometry without forcing you to give up parametric functions.

**Normalize Spline**
The Normalize Spline modifier places additional control points along a spline. The control points are spaced at regular intervals. This can be useful when using splines for motion paths where a constant speed is required.

**Optimize**
The Optimize modifier simplifies the geometry of an object while maintaining an acceptable level of detail. This offers the benefits of faster rendering time and less RAM usage. This modifier has effectively been replaced by the MultiRes modifier.

**PatchDeform**
This modifier allows you to deform an object based on the form of a Patch object. A Patch object is an object that can be formed into a smooth, curved surface by editing its vertices. You can, for example, create a plane and then convert the plane into an editable patch. The vertices of the editable patch can then be edited to shape the plane into a smooth, curved surface of any shape you want. Such a surface can be used to deform other objects, using the PatchDeform modifier.
The object remains in its current location while being deformed. See also the WSM version of this modifier.

**PathDeform**

The PathDeform modifier works in a way similar to the PatchDeform modifier but uses a spline or NURBS curve instead of a Patch object. For example, you can use this modifier to deform an object along the path of the spline. An example of this would be the curving of text to conform to the shape of a round column or sphere. The object does not move to the path with this modifier. See also the WSM version.

**Physique**

The Physique modifier is used to allow the movement of a linked bone or hierarchical system to deform the mesh to which it is applied, and it is often used for character/creature or other organic animation.

**Point Cache**

The Point Cache modifier is used to save only the changes in vertex position, rotation, and scale information of modifier and sub-object animations to disk so that they can be played back, often faster than trying to play the modifier animation back in real time.

**Preserve**

The Preserve modifier lets you “clean up” a mesh that has been edited on a vertex sub-object level. Often, when a mesh is edited by moving vertices, the resulting form takes on a rough appearance. The Preserve modifier will help smooth out that rough appearance.

To use the Preserve modifier, you must first make a copy of the object you want to modify. Make your changes to the copy’s vertices, and then with the vertex sub-object level still active, apply the Preserve modifier. Use the Pick Original button of the Preserve modifier to select the original object from which you made the copy. You can then use the other Preserve modifier controls to adjust the mesh.

**Projection**

The Projection modifier is used to place the normal map information of a high-resolution object onto a low-resolution object.

**Projection Holder**

The Projection Holder modifier stores the information created in the Project Mapping process.

**ProOptimizer**

The ProOptimizer modifier allows you to interactively optimize the polygon/vertex count of selected objects with a number of parameters while maintaining the appearance of the object. There is also a Batch ProOptimizer utility that allows you to optimize multiple files simultaneously.
**Push**

If you need to create a bulging or shrunken appearance, you can use Push. The Push modifier has a single parameter that pushes or pulls the vertices of an object from its center.

**Quadify Mesh**

The Quadify Mesh modifier can be used to increase the geometry of your model and convert the triangular geometry to quadrilateral polygons. This modifier can be very helpful on Boolean objects and objects to which you want to apply the MeshSmooth or TurboSmooth modifier.

**Relax**

Relax is similar to Push, but instead of pushing vertices out from the object’s center, Relax softens the corner edges of an object or generally relaxes an object’s shape to something smoother, with less-pronounced surface changes, by evening out the distribution of vertices in an object based on the parameters you select.

**Renderable Spline**

This modifier lets you set the renderable parameters of Spline objects, including those that are brought into 3ds Max through importing or file linking (see Chapter 5, “Working with External Design Data”) from an Autodesk® AutoCAD®-based application, without collapsing the splines to editable splines.

---

**3ds Max vs. Non-3ds Max Splines**

Splines made in 3ds Max do not require the use of the Renderable Spline modifier because they already have the same controls available in their Rendering rollout.

---

**Ripple**

Ripple modifies an object’s surface to produce a concentric rippled effect. You can control the amplitude, wavelength, phase, and decay of the ripple.

**Select By Channel**

The Select By Channel modifier operates with the Channel Info utility, allowing you to access stored vertex selections easily.

**Shell**

This modifier extrudes a flat or curved two-dimensional or three-dimensional surface, giving it volume and solidity.

**Skew**

The Skew modifier skews an object, as shown in Figure BA1.10. You can control the direction and strength of the skew. You can also limit the skew to a portion of the object.
Figure BA1.10
A cylinder skewed using the Skew modifier

**SKIN**
When the Skin modifier is applied to an object, it allows you to deform it based on other linked objects, such as bones or another hierarchical system.

**SKIN MORPH**
The Skin Morph modifier can be used with the Skin and Physique modifiers to allow the rotation of a bone to drive the value of morph targets, such as to create bulging muscle animations or to fix problem areas in a rigged character.

**SKIN WRAP**
The Skin Wrap modifier allows multiple objects to deform another object.

**SKIN WRAP PATCH**
When applied to a mesh object, the Skin Wrap Patch modifier allows that mesh object to be deformed by a patch object.

**SLICE**
Slice allows you to define a plane through which objects can be cut. There are two ways in whichSlice can affect an object. The most obvious is splitting a single object into two distinct objects. Slice gives you the option to keep both parts of the split object, or you may hide one part. Slice also lets you refine an object along the intersection of the slice plane with the object.

**SMOOTH**
The Smooth modifier applies autosmoothing to the surface of an object. Although you can usually apply smoothing to an Editable Mesh at the sub-object level, Smooth allows you to control the smoothing as an item in the mesh’s modifier stack.
**SPHERIFY**

The Spherify modifier lets you distort an object into a spherical shape. It offers a single parameter that lets you control the amount of distortion you can apply to the object.

**SQUEEZE**

Squeeze lets you move the vertices of an object along the Z-axis. The vertices closest to the object’s pivot point are moved the farthest. If you apply Squeeze to a box, for example, the vertices at the center of the top surface are pushed or pulled farther than the ones toward the edge, creating a bulging effect or a cupping effect, as shown in Figure BA1.11.

![Figure BA1.11](image)

Cupping and bulging a box with the Squeeze modifier

Squeeze can also be made to affect the vertices along the Y- and Z-axes to create a flare or a crimping effect, as shown in Figure BA1.12.

![Figure BA1.12](image)

Crimping and flaring a box with the Squeeze modifier
**STL Check**

If you plan to export your 3ds Max model for use with stereolithography (STL) equipment, you can use the STL Check modifier to check your design for correct export. STL Check is also used after performing Boolean operations. Use STL Check to see if the Boolean introduced any discontinuities or errors in the mesh. If so, add a Cap Holes modifier and then collapse the mesh.

**STRETCH**

If you just want to squash or stretch an object along a single axis, you can do so using the Stretch modifier. If you apply a positive Stretch value to this modifier, the object elongates along the selected axis while contracting along the other two axes, as shown on the left in Figure BA1.13. Applying a negative Stretch value causes the object to shrink along the selected axis while bulging out in the plane of the other two axes, as shown on the right in Figure BA1.13.

![Sample boxes that are stretched and squashed using the Stretch modifier](image)

**Subdivide**

The Subdivide modifier, an OSM version of the Subdivide WSM modifier, allows you to manually apply a radiosity mesh to an object. Subdivide works in a similar way to the Radiosity Meshing parameters; however, instead of applying a mesh globally, Subdivide lets you apply a mesh to single objects or even sub-object levels. Because it’s a modifier, it can be edited directly from the modifier stack.

**Substitute**

The Substitute modifier lets you substitute one object for another. This feature is useful if you have a complex scene and want to simplify part of it to help speed up editing or rendering. You can substitute a simple object for a complex one while editing. Then, at render time, you can have 3ds Max restore the original complex object. You may also do the reverse for quicker rendering of sample views. The Substitute object can come from the current design or from an external file. Substitute objects are removed by deleting the Substitute modifier from the stack.
SURFACE
The Surface modifier applies a patch surface over a set of interconnected spline segments. The segments must all be of one object and must be joined at their vertices. The Surface modifier applies patch surfaces to three- and four-sided polygon formations of the interconnected segments. See the CrossSection modifier earlier in this section to see the Surface modifier applied to a series of splines connected with a CrossSection modifier.

SURFDEFORM
The SurfDeform modifier works in a way similar to the PatchDeform modifier but uses a NURBS surface instead of a Patch object. You can use this modifier to deform an object, based on the shape of a NURBS surface; similar to the way you would use a patch surface.

SWEEP
The Sweep modifier is similar to the Bevel Profile modifier in that it extrudes a shape along a spline path. Sweep is much more powerful in that it can use multispline, noncontiguous shapes as paths, eliminating the need to break complex splines into individual objects. Sweep is very fast, can use any shape as the cross section, and has a library of cross-sectional shapes, mostly relevant to structural steel components, from which to choose. Sweep also lets you use custom-defined shapes. See the tutorial in Chapter 6, “Organizing and Editing Objects,” that uses this modifier.

SYMMETRY
Like the Mirror modifier, the Symmetry modifier mirrors the selected object about a plane to replicate the geometry. The Mirror plane can be oriented in the X-, Y-, or Z-axis, and the Flip option swaps the side used as the reference side. The offset between the two halves is determined by moving the Mirror sub-object perpendicular to the orientation of the plane. See the tutorial in Chapter 6 that uses this modifier.

TAPER
The Taper modifier allows you to taper an object along a specified axis. See Chapter 2 and Chapter 4, “Editing Meshes and Creating Complex Objects,” for a more detailed look at the Taper modifier.

TESSELLATE
The Tessellate modifier divides the faces of a surface into multiple, smaller faces. It can have the effect of smoothing a surface. You can also use it to increase the number of faces in a region of a surface for further editing. If Tessellate is applied to an object, all the faces of the object are tessellated (see Figure BA1.14). You may also enter the Face sub-object level to select a specific set of faces for tessellation.

Tessellate is also an option in the Face, Polygon, and Element sub-object levels of Editable Meshes and at all levels of Editable Polys.
Figure BA1.14
A surface before and after tessellation

Trim/Extend
The Trim/Extend modifier works just like the Trim/Extend options in the sub-object level of Editable Spline objects. You can trim open spline segments to other existing, overlapping segments within a single object, or you can extend open segments to other segments within the same object that lie in the direction of the segment end. The Trim/Extend modifier is offered for those situations where it’s preferable to include Trim/Extend operations within the modifier stack.

TurboSmooth
The TurboSmooth modifier smooths geometry by subdividing the mesh, and it is comparable to the MeshSmooth modifier. TurboSmooth, however, calculates and implements the smoothing much faster and has a streamlined user interface. The MeshSmooth modifier has a larger toolset, and it should be used only when access to these tools is required.

Turn To Modifiers
Turn To modifiers let you convert objects from one type to another with the modifier stack. You can then apply other modifiers to control the converted object.

- **Turn To gPoly**: Converts objects to the 3ds Max internal hardware mesh format, resulting in greater performance when the mesh is deformed.
- **Turn To Mesh**: Converts objects to meshes.
- **Turn To Patch**: Converts objects to patches.
- **Turn To Poly**: Converts objects to polygonal objects.

Twist
The Twist modifier deforms an object by twisting it along a selected axis. Figure BA1.15 shows a box that has a Twist modifier.
**Unwrap UVW**

This modifier is used to assign planar texture maps to sub-object selections. Unwrap UVW can also assign UVW coordinates to a model. The Automatic Flatten UVs (Unwrap UVW) modifier is applied during the Render To Texture process where each object is UV mapped so that the resulting textures can be applied to the object surfaces.

**UVW Map**

This modifier lets you control the orientation of maps on the surface of an object. It also lets you control the size and aspect ratio of a map in relation to the object to which it is mapped. UVW Map offers a set of mapping types that allow you to tailor the map to the shape of an object. For example, if you are applying a material to a cylindrical shape, you can use the Cylindrical Mapping parameter that projects the map in a cylindrical form. A UVW Map gizmo gives you a visual reference for the location and orientation of the mapping parameters. You can use the transform tools to adjust the Map gizmo. When paired with selection modifiers, different parts of a single object can have different mapping coordinates.

**UVW Mapping Add**

The UVW Mapping Add modifier is used in conjunction with the Channel Info Utility and appears in an object’s modifier stack when you use the Channel Info Utility to add a channel.

**UVW Mapping Clear**

The UVW Mapping Clear modifier is used in conjunction with the Channel Info Utility and appears in an object’s Modifier stack when you use the Channel Info Utility to clear a channel.

**UVW Xform**

You can use the UVW Xform modifier to control the way a material map is applied to an object. Many 3ds Max objects offer built-in mapping coordinates, such as the general coordinates for standard primitives and lofted objects. Unfortunately, those built-in mapping coordinates don’t
offer the tiling and offset options found in the UVW Map modifier. The UVW Xform modifier is
offered to allow tiling and offset control over mapping in objects that have built-in mapping.

**VERTEX WELD**
This is like the Weld sub-object vertex feature in the Edit Mesh and Edit Poly modifiers, and it
merges vertexes based on the distance in the Threshold parameter.

**VERTEXPAINT**
This is used to paint vertex colors on objects.

**WAVE**
The Wave modifier produces a linear wave effect on the selected geometry. You can control
the amplitude, wave length, phase, and decay of the waves; the amount of segmentation in the
object determines the smoothness of the wave. More segments produce smoother waves.

**WELDER**
The Welder modifier can be used to fix meshes that have tears, or duplicate coincident vertices,
by welding vertices or faces.

**XFORM**
The transforms (Move, Rotate, Scale) are not transferred to other objects or instances; all objects
must be selected for any transform to have an effect. The XForm modifier is intended to allow
transforms to exist within the modifier stack. XForm modifiers cause transforms to be applied
to all objects with the instanced modifier in their stack. This makes it useful for trial purposes,
since you can easily delete the XForm modifier from the stack—something you cannot do with
the standard transform tools on the Main Toolbar. This is most important when applying a Scale
transform to an object that is in a hierarchy. If you scale the XForm gizmo, you avoid problems.
If you simply scale at the object level, that Scale transform will be passed down to the children,
and it will usually introduce skewing and other distortions during animation.

**Materials and Maps**
*Mastering Autodesk 3ds Max 2013* focuses on a few of the materials available in 3ds Max, and for
probably 80 percent of your projects, your needs won’t go beyond the material types shown in
the tutorials of this book. For the remaining 20 percent, you’ll find the range of materials offered
by 3ds Max indispensable.

This section provides a description of all the materials available in the 3ds Max Material/
Map Browser for use with the Default Scanline Renderer. Just as in the preceding “Modifiers”
section, you may want to read about these material options for future reference.

**The mental ray Materials**
The latest release of 3ds Max uses NVIDIA’s mental ray 3.10. The specialized mental ray mate-
rials and map shaders are covered in Chapter 8 and Chapter 14, “Advanced Rendering Using
mental ray.” You can refer to Help ➔ Additional Help ➔ mental ray Help for detailed notes on
the many mental ray shaders that are available. In the Material/Map Browser, there is a mental ray Materials rollout with a complete list of the types now available. Materials that import from Revit via FBX are assigned the new Autodesk Material type to ensure complete compatibility between the 3ds Max and Autodesk® Revit® platforms. This is a mental ray material that was new to 3ds Max 2011. It features an easy-to-use interface with fewer controls and less confusion for the novice. As with Standard materials, there are material libraries with preset materials available for you to use. This material was preceded by the ProMaterial type, a similar mental ray material. Before there were ProMaterials, the Arch & Design (A&D) material was the primary mental ray material in use.

For complete information about individual material types, see the Types of Materials topic in the 3ds Max Help. The mental ray materials included in this release are listed here. This list will only mention the unique features for each material; common mental ray features such as cutout maps, ambient occlusion, round corners, and performance tuning won’t be included in each description.

ARCH & DESIGN
This is the most widely used material by the mental ray visualizer. It has the most complete accessibility to all the functions you can control and consequently the most complex interface. It uses templates like the Architectural material. When in doubt, use A&D materials.

AUTODESK CERAMIC
This limits your choices to Porcelain or Ceramic (unglazed earthenware), and it lets you enable bump (crazing) and relief mapping (patterns stamped in the clay)—High Gloss/Glazed, Satin, and Matte Finish options.

AUTODESK CONCRETE
Choose the type of sealant, from None, Epoxy, and Acrylic, and type of finish, from Broom Straight, Broom Curved, Smooth, Polished, and Stamped/Custom. This also includes a weathering option that can work automatically or based on a map that you select.

AUTODESK GENERIC
This is probably the material you want to start using first as you explore the new Autodesk materials. It has all the features available in one place. Features include color, image, image fade, glossiness, highlights, direct and oblique reflectivity, transparency/translucency/refraction, cut-out, self-illumination, bump channels, ambient occlusion, round corners, performance tuning parameters, and the ability to override the refraction depth. The Cut-out map is a separate opacity-masking channel, independent of the transparency channel.

AUTODESK GLAZING
This is a window glass shader. You select the number of sheets of glass, reflectance, and color. More sheets of glass create more reflection/refraction. Don't use this for solid glass objects; use this for windows and curtain walls.
**Autodesk Hardwood**

This lets you choose an image map to use, a stain color, and a finish from Glossy, Semi-gloss, Satin Varnish, or Unfinished. You can select a use of furniture or flooring, and you can assign a relief pattern based on the wood grain or from a unique image.

**Autodesk Masonry CMU**

This material gives you a choice of masonry or CMU (Concrete Masonry Unit). You can use a selected color, a selected image map, or the color of the object. There is a finish choice of Glossy, Matte, or Unfinished, and you can select an image and set the value for the relief pattern.

**Autodesk Metal**

This includes eight types of metal: Aluminum, Anodized Aluminum, Chrome, Copper, Brass, Bronze, Stainless Steel, or Zinc. The finish choices are Polished, Semi-polished, Satin, and Brushed. The relief pattern options include Knurl, Diamond Plate, and Checker Plate, or you can select your own custom image map.

**Autodesk Metallic Paint**

This is a preset layered material with four unique layer groups: one for the metallic paint color, one for flecks, a pearl (polish) layer, and a top coat. This functionality is also available using the Car Paint material.

**Autodesk Mirror**

This material has minimal choices. You can assign a tint color or use the object’s color. Mirrors reflect 100 percent of the objects and environment. Use this on both planar and curved surfaces alike; it is not limited to flat surfaces.

**Autodesk Plastic/Vinyl**

This provides choices including solid or transparent plastic or vinyl. You can select a color, use a map, or use the object’s color. Finish choices are Polished, Glossy, or Matte.

**Autodesk Solid Glass**

Use this for nonwindow glass objects, such as goblets, cut glass bowls, chandeliers, and so on. This material provides predefined colors including Clear, Green, Gray, Blue, Blue Green, Bronze, and Custom. You can assign a reflectance amount, the Index of Refraction, and the surface roughness.

**Autodesk Stone**

Use this for polished or unfinished stone based on a diffuse channel map, with bump and relief channels.
AUTODESK WALL PAINT
This material allows you to select the color or use the object’s color. The finish options are Flat/Matte, Eggshell, Platinum, Pearl, Semi-gloss, and Gloss. You can also select the application method (Roller, Brush, or Spray).

AUTODESK WATER
This material has a Type with choices of Swimming Pool, Generic Reflecting Pool, Generic Stream/River, Generic Pond/Lake, Generic Sea/Ocean, plus a Wave Height option used for setting subtle wave effects.

CAR PAINT
This is a layered material type with six layer groups: a Diffuse Coloring layer with eight settings, a Flakes layer with eight settings, a Specular Reflections layer with seven settings, a Reflectivity layer with eight settings, a Dirty Layer (Lambertian) with Dirt Color and Dirt Weight settings, and an Advanced Options layer with two settings.

MATTE/SHADOW/REFLECTION
Use this just as you would use the Matte/Shadow material for the Default Scanline Renderer.

MENTAL RAY
If you’re going to use the stand-alone mental ray renderer, you should use this material. It’s designed for rendering outside of 3ds Max 2013.

SUBSURFACE SCATTERING FAST MATERIAL, SUBSURFACE SCATTERING FAST SKIN, SUBSURFACE SCATTERING FAST SKIN+DISPLACEMENT, AND SUBSURFACE SCATTERING PHYSICAL
All the Subsurface Scattering materials mimic the appearance of light passing through a top layer and scattering within a second layer, such as wax candles, jade, and skin.

mental ray Shader Map Types
The mental ray shader map types available to use in material map channels included in this release are listed here. See the Material Shaders Rollout topic in the 3ds Max Help System for details about each of these.

Ambient/Reflective Occlusion   Ambient occlusion is often called a dirt shader, crevice shader, or detail shader. It adds gradation into fine detail areas, adding realism.
Car Paint   This is the same material functionality described earlier, available as a map.
Color Override/Ray Type Switcher   Put this in any channel where you want to replace the color or image that’s currently applied with a different one of your own choosing. You can use this to override many different channels, including environment, photon, and Final Gather illumination.
Edge   This blurs edges on bump-mapped objects in profile.
Environment Blur  All the environment shaders work on different aspects of the background; this one adds blur to the environment map rendering.

Environment Probe/Chrome Ball  This is used to map the correct ray direction based on a light probe (chrome ball). By shooting a gray or chrome ball in a scene, you can match CG lighting to the actual lighting in a photo or film sequence.

Environment Probe/Gray Ball  See Environment Probe/Chrome Ball.

Environment/Background Camera Map  This projects the background map based on a camera position.

Environment/Background Switcher  This lets you have one map to use as a background and a second one for environment map reflections.

Facade  This speeds rendering by placing “cardboard cutouts” in the scene, replacing complex geometry.

Gamma & Gain  Also called Utility Gamma & Gain, this adds a simple multiplier to a color or map. Use this to intensify maps, similar in usage to the Output rollout on the standard bitmap.

Glow  This adds an aura around a light or object, simulating light coming from an object or source.

Kelvin Temperature Color  Color temperature, a numeric measure of light energy, can be defined using this shader. Generally, changing this is similar to changing white balance on a video camera; it tints everything to blue or orange.

Landscape  This maps textures to terrains based on slope and height and includes noise and image adjustments too.

Material To Shader  This lets you assign Max Standard materials as a shader map for mental ray.

Metal  Metal creates realistic metallic surface treatments in mental ray.

mr Labeled Element  This is used to output any branch of a shader tree to a render element.

mr Physical Sky  This is used in conjunction with mr Sun and Sky; it provides an environment map with a sun disk, horizon, and ground plane. Adding a bitmap in the haze channel lets you create clouds in the mr Physical Sky.

Multi/Sub-Map  This is a special shader that assigns multiple maps or colors to a single parameter of a material. It’s useful for randomizing coloration of arrays of objects that would otherwise appear too regular and artificial.

Object Color  Applies the wireframe color as a map in any material. There are additional white and black channels used to blend these into the color.

Ocean  This is a water shader that creates realistic wave patterns over an ocean as seen from a great distance.

Shader List (Texture)  This lets you build up multiple shaders in a list, so the output of one becomes the input for the next.

Stain  This is combined with other shaders to provide “discoloration” in the main shader.
Subsurface Scattering Physical  This gives the illusion of two layers in which light passes through the top and is dispersed in the underlayer.

Translucency  This simulates how surfaces look as light passes through a surface from back to front.

Transmat  Short for transparent material, this is used with parti-volume shaders to make transparent the enclosing surface of a volume.

Water Surface  This simulates how water looks based on angle of viewing, changing reflection and changing transparency accordingly.

Wet/Dry Mixer  This creates two surfaces (one wet, one dry) with separate bitmap textures for each (one shinier and more saturated than the other).

Standard Materials
When you use the Material/Map Browser, at the very top level you’ll see expandable group rollouts for Materials, Maps, Autodesk Material Library, Scene Materials, and Sample Slots. The following list contains the items found in the Materials ➔ Standard rollout. To see all the entries, you need to use the Options menu and select Show Incompatible.

Advanced Lighting Override
This material is used to fine-tune legacy radiosity materials. This material gives you direct control over the radiosity properties of a material. This material is an adjunct to the base material, and it has no effect in nonradiosity renderings. You can control properties such as reflectance, color bleed, and transmittance. It used to be called Radiosity Override in early releases.

### ADVANCED LIGHTING OVERRIDE AND THE ARCHITECTURAL MATERIAL

The Architectural material has an Advanced Lighting Override rollout with the same controls available in this material.

Architectural
This is a Standard material that has a unique interface primarily created for architectural visualization. The material is physically accurate and designed to be used with the Radiosity renderer, but it works very well with the NVIDIA mental ray renderer with a few limitations. See the 3ds Max Help System for more information on the Architectural Material. The Architectural material has 24 template types for materials, such as Ceramic Tile, Fabric, Glass, Ideal Diffuse, Masonry, Metal, Mirror, Paint, Paper, Plastic, Stone, User Defined, Water, and Wood. If you have switched your default settings and custom UI to the DesignVIZ settings, it will make the Architectural material the default in the Material Editor. DWG files may import with these materials if they come from older versions of AutoCAD.

Blend
You can mix two materials into a single material by using the Blend material. Blend offers the ability to control the strength of each material.
**Composite**

Composite materials allow you to superimpose up to 10 materials. You can apply additive or subtractive opacity to each material or control the strength of the individual materials.

**DirectX Shader**

The DirectX Shader allows you to apply DirectX (Direct3D) shaders to objects in your viewports. Using DirectX shading will give you a better idea how your objects and materials will look in applications such as game engines or other real-time applications.

**Double Sided**

You can assign a different material to the front and back or the normal and non-normal sides of an object with a single surface by using the Double Sided material. When you select this material type, you can use the Double Sided basic parameters to select a material for the Facing material and another material for the Back material. This is different from the 2-Sided option available in several materials, which applies the same material to both sides of all surfaces.

**Ink 'n Paint**

The Ink 'n Paint material is used for creating nonphotorealistic renderings and can be used to create the appearance of 2D cartoons, technical illustrations, and stylized architectural renderings.

**Matte/Shadow**

A Matte/Shadow object has the effect of making itself and anything behind it invisible so that you can see through the scene all the way to the background. It’s most frequently used in conjunction with environment maps where a design is to be blended into the background image. For example, suppose you have a fairly detailed background image of a city’s downtown area, complete with skyscrapers. To create the illusion that your new building exists in the midst of the existing structures, first place your building in 3ds Max accurately in relation to the other buildings in the background image. Next, create simple boxes in the foreground, and modify them to match the perimeters of the buildings in the background image. Apply the Matte/Shadow material to the boxes, and it will appear that the buildings in the background are actually in front of your 3ds Max building.

You can also use Matte/Shadow objects to add shadows to objects in a background image. For example, suppose you are using the Camera Match tools to match a car design to a background image of the building’s site. In the real world, your design would cast shadows on the ground, but in your 3ds Max scene, you would leave out the ground so that the ground in the background image could come through in the rendering. Unfortunately, when you do this the design doesn’t cast a shadow on the ground because the ground does not actually exist as geometry in the scene. This unnatural absence of a shadow creates an odd, floating appearance. You can add a ground plane to your design and assign the Matte/Shadow material to this ground plane. The ground plane will be invisible when it’s rendered; yet it will receive a shadow, creating the illusion that the car is casting a shadow on the ground of the background image.

Figure BA1.16 shows a rendering of a car using the background from the Camera Match exercise of Chapter 9, “Using the Camera.” Notice the shadow of the car in the image. To obtain that...
shadow, a surface was placed under the car and a Matte/Shadow material was applied to the surface. The Receive Shadow option was also turned on for the Matte/Shadow material.

**Figure BA1.16**
A 3D car model is rendered onto a background image

Matte/Shadow materials behave in a way similar to the effect of the Camera Map modifier. The main difference here is that the Camera Map modifier is view dependent, while the Matte/Shadow material affects all views.

**Morpher**
The Morpher material works in conjunction with the Morpher modifier. Note that this material is not compatible with mental ray.

**Multi/Sub-Object**
The Multi/Sub-Object material is like a collection of separate materials under a single material name. Multi/Sub-Object materials are useful in situations where you want to assign multiple materials to a single object. See Chapter 8 for more on the use of Multi/Sub-Object materials.

**Raytrace**
Raytrace materials reflect and refract light in a way that simulates one of the ways light actually works. The term *ray tracing* comes from the way the program traces the path of light from a pixel in the rendered image back to the light source. Raytrace materials are best used for transparent or shiny materials, such as glass or water, that reflect or refract light. Figure BA1.17 shows a rendering of a sample file from 3ds Max. The goblet in the figure uses the Raytrace material.

**Shell**
The Shell material is used for storing and rendering baked textures created by the Render To Texture feature when the Baked Materials setting is Save Source (Create Shell), which is the default setting. The Save Source (Create Shell) option allows for the creation of a Shell material while saving the original one with options for displaying in the viewport and/or rendering.
Figure BA1.17
The wineglass modeled in Chapter 3 rendered using the Raytrace material

**Shellac**
A Shellac material lets you create a shellac effect by combining two materials. One, called the Base material, is used for the underlying base. The second, the Shellac material, is applied over the base with some transparency. You can control the transparency and blending of the Shellac material.

**Standard**
The Standard material is the default material in the Material Editor. It’s covered in some depth through the tutorials in this book. It offers a wide variety of shaders, and you can include several different types of maps (described in the next section). With the available combination of shaders and maps, you can create nearly any effect you need for materials.

**Top/Bottom**
The Top/Bottom material lets you assign a different material to the top and bottom of an object based on the object’s local Z-axis. An example of this might be a two-tone car body. You can control the position and blending of the two materials.

**XRef Material**
When you externally reference (XRef) an object or scene into the current scene, that object or scene’s materials come with it. The XRef material allows you to XRef any material from another scene into the current scene’s Material Editor without bringing any geometry with it.

**Standard Maps**
The materials discussed in this book allow you to apply maps in several different ways. Maps can be used to control reflection, opacity, bumpiness, transparency, and so on. This book focuses on the use of bitmaps for most of the material map applications, but there are several other map types that you’ll want to know. This section describes the different Standard map types and how they might be used.
NONE
This option is used to remove a map assignment from a material. It does not appear in the Material/Map Browser, but you can copy it from unused material channels in a material to replace a map you no longer want to use in the material.

BITMAP
The Bitmap option is described thoroughly in this book. It allows you to use any bitmap image as a material map. It’s perhaps the most flexible option because thousands of bitmaps can be acquired from a wide variety of sources. You can create fairly credible materials through the use of bitmaps.

CAMERA MAP PER PIXEL
The Camera Map Per Pixel map projects a bitmap image from the direction of a specified camera onto objects in the scene and is beneficial in the use of matte paintings in renderings.

CELLULAR
The Cellular map is a procedural map that creates a variety of cellular, or granular, material effects. With this map, you can create materials ranging from terrazzo to polystyrene foam. The Cellular map is fairly complex, so you may want to experiment with it on your own to see what types of results it produces.

CHECKER
The Checker map is a procedural map that creates a checkerboard pattern. You can assign a color or another map to the squares of the checkerboard. You can also add noise to create a more natural appearance and specify the amount of tiling in each direction. The Checker map can be useful when trying to visualize UVW Mapping on an object; you can apply the Checker temporarily and then, when the UVW Mapping is accurate, replace it with your final texture.

COLOR CORRECTION
The Color Correction map allows you to adjust the appearance of a child map, using a number of tools similar to what you would find in an image-editing application.

COMBUSTION
The Combustion map works in conjunction with Autodesk® Combustion® compositing software.

COMPOSITE
A Composite map is a map formed from the combination of other maps. Mask maps are used to control blending of the Composite maps.
**Dent**
Dent is a procedural 3D map that produces a random, dented surface. You can control the depth and size of dents through the map's parameters. You can also apply other maps to the Dent map to create a multicolored surface.

**Falloff**
The Falloff map is primarily used as an opacity map. When applied to an object as an opacity map in its default mode, the object appears most transparent at its center and least transparent around its edges, like a clear balloon or glass ball. This is the same effect as the Falloff setting in the Extended Parameters rollout of the Standard material, with some added control.

**Flat Mirror**
The Flat Mirror map is used primarily as a reflection map. It produces a mirrorlike finish on a flat surface, reflecting the environment and objects nearby. To use this material, you must apply it directly to coplanar faces of an object on a sub-object level. This can be done by including Flat Mirror in the reflection channel in a sub-material of a Multi/Sub-Object material. It is a good practice to reduce the Amount value for the reflection channel when using a Flat Mirror (unless an actual mirror is being modeled) to reduce the reflection amount to a more realistic value.

**Gradient**
The Gradient map lets you create a color gradient using three colors. You can adjust the location of the middle color in the gradient, and you perturb the gradient by using the Noise parameters.

**Gradient Ramp**
The Gradient Ramp map is similar to the Gradient map, but it allows for a greater range of colors.

**Map Output Selector**
This is a required map that must go between a multi-output map, for example, the Substance map, and the material channel to which the Substance map is connected. It is designed to allow you to access the Substance map and adjust the channel index and the channel name to which the map is applied.

**Marble**
The Marble map simulates the appearance of marble. You can control the color of the marble veins and the background, and you can also adjust the size of the veins.

**Mask**
The Mask map uses two maps. One map is used as a base map, while the second map is a mask. The mask controls the visibility of the base map.
**Mix**

The Mix map allows you to combine two colors, two maps, or a color and a map and adjust the influence of each on the material.

**Noise**

The Noise map creates randomness in the form of a grayscale pattern. Noise can be used to create a bump pattern or a granite surface. Parameters let you adjust the scale and intensity of the noise.

**Normal Bump**

The Normal Bump map allows you to apply specially created Normal maps to objects to add detail to the object, and they are usually used in the Bump or Displacement components of a material.

**Output**

Bitmaps offer control over the bitmap image through the Output rollout. Such controls aren’t available for many of the procedural maps. The Output map is like a modifier for procedural maps that gives you the same Output rollout options as bitmaps.

**Particle Age**

The Particle Age map affects the appearance of a particle according to its age. There are three phases you can assign to a particle by percentage of its age.

**Particle MBlur**

The Particle MBlur map can be applied to a particle system to change the opacity of the particles’ leading and trailing edges according to how fast the particles are moving.

**Perlin Marble**

Perlin Marble creates a marble pattern using what is called the *Perlin Turbulence algorithm*. The Perlin pattern has a more swirled appearance.

**Raytrace**

Like the Raytrace material, the Raytrace map provides raytraced reflection and refraction for objects to which it is assigned. It’s most suitable for highly reflective surfaces or transparent materials. Using the Raytrace map in a material slot, rather than as a material, allows you to limit the portions of the object that are raytraced and reduce the amount of processing time required to render a frame. See “Raytrace” in the earlier “Materials” section for more information.

**Reflect/Refract**

The Reflect/Refract map simulates reflection and refraction of backgrounds in the environment of the design. It does this by mapping the environment onto a cube surrounding the mapped object and then using that cube as a reflection map.
RGB Multiply
The RGB Multiply map combines the effects of two maps. This map is commonly used for bump maps.

RGB Tint
The RGB Tint map lets you apply a color tint to another map. You first insert the RGB Tint map; then, through its parameters, you attach a second map. You can then use the R, G, or B color swatch in the RGB Tint parameters to tint the second map.

Smoke
The Smoke map creates noise in a smoke-like pattern. It’s more commonly used as an opacity map for simulating smoke than as a diffuse color map.

Speckle
The Speckle map creates a speckled appearance using two colors, two maps, or a color and a map. You can use it for diffuse or bump maps to create a speckled-egg look.

Splat
Splat produces a splattered-paint look. Its controls are similar to those for Speckle. You can use two colors, two maps, or a color and a map to produce the splat effect.

Stucco
The Stucco map is designed to create a stucco surface and is commonly used as a bump map.

Substance
The Substance maps from Allegorithmic (www.allegorithmic.com), which were a new feature of 3ds Max 2012 (they made their first appearance with the Subscription Advantage Pack for 3ds Max 2011), are used to access the 73 Substance texture maps and 10 Substance noise maps that are included with 3ds Max 2013. When you add a Substance map to a material channel, you will load any of the previously mentioned procedural maps and set the resolution parameters and then any of the available parameters of that specific map. These parametric maps can also be animated. You can purchase additional maps from the Substance Marketplace. If you want to create new Substance parametric maps, you need to purchase the Substance Designer.

Swirl
Swirl creates a swirl pattern from two colors or maps.

Thin Wall Refraction
The Thin Wall Refraction map creates the illusion of refracting glass. When applied to a thin box representing a glass panel, it offsets the view behind the glass panel, simulating a refracted appearance. This map requires less time to render than the Reflect/Refract map or the Raytrace map. Therefore, in well-lit, close-up views, it offers a good alternative to those maps.
**Tiles**

The Tiles map is a procedural map that allows you to parametrically control the appearance of courses of brick or block. You can control the type of tile joint as well as the color and texture of the tile pattern through this map. Several common brick and block patterns are available to select from and then customize.

**Vector Displacement**

The Vector Displacement map, which is only compatible with mental ray, allows you to displace geometry in three dimensions, not just along the surface normal. This map is best used with content imported into 3ds Max from the Autodesk® Mudbox® digital painting and sculpting application.

**Vertex Color**

You can apply regions of color to an Editable Mesh by assigning color to vertices in the mesh. These vertex color assignments become visible when you apply the Vertex Color map to the mesh. To apply a color to a vertex, select the mesh and then click the Modify tab. Click the Vertex option in the Modify tab’s Selection rollout, select a vertex or set of vertices, scroll down to the Vertex Color group, and edit the colors. After assigning a color to a vertex, create a material that uses the Vertex Color map as a diffuse map; then apply the material to the object. The Terrain object automatically applies a Vertex Color map when you create Color by Elevation.

**Waves**

The Waves map simulates the surface of water. It can be used as a diffuse color map and bump map at the same time to create a rippling, water-like surface. You can control the amplitude and size of ripples.

**Wood**

The Wood map simulates the qualities of wood grain. It is a 3D procedural map, which means that the wood-grain effect is carried through the volume of the object to which it is applied. If you cut a notch out of the object, for example, you’ll see the grain accurately reproduced in the notch, as in a real piece of wood. You have the option of controlling two colors for the wood grain, the grain thickness, and the amount of noise or straightness in the grain.